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Overview

Contests are a core method of engaging YouTube community members and encouraging them to
interact with your brand. Contests create unique opportunities to blend your own content with
user-generated assets on your brand channel page. Contests encourage multiple levels of
participation:

• Brand enthusiasts, motivated by loyalty and affinity for your product, create unique
content that showcases your brand image.

• Budding video directors, encouraged by the visibility that your contest affords their
videos and by the prizes for winning videos, channel their creative energies toward
creating new videos that communicate your brand identity.

• YouTube community members are drawn to your brand channel, which becomes a
source of interesting, new, and often professional-quality video content.

Information about your contest appears on your brand channel page, creating an integrated brand
experience for YouTube users and allowing you to provide a single destination for your brand on
YouTube. Brand channel pages that showcase contests still have access to all standard brand
channel features, including custom graphics, a branding box and automatic featured video
playback. Please refer to the Creating and Customizing a Brand Channel document for
information about designing your brand channel and selecting content for your channel page.
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About this document

This document is an addendum to the Creating and Customizing a Brand Channel document,
which explains unique features available to brand channels and discusses the process of
designing and customizing a brand channel.

This document supplements the standard brand channel information by explaining how to set up
and run a contest on your brand channel. This document is divided into the following sections:

• The Creating a YouTube contest section describes the steps you are likely to follow
when creating your brand channel. This section intends to give a high-level overview of
the actions you will need to complete to set up your contest. The remaining sections
contain general information about contests as well as detailed instructions for using
YouTube's contest interface to help you to complete these tasks.

• The Contest phases section outlines the typical stages of a YouTube contest and
suggests best practices for each contest stage. This section contains background
information that will help you to set up your contest. This section also provides a sample
timeline for running a contest.

• The Understanding the contest module and Gadget Ad section shows a wireframe image
of the contest module and describes the different visual elements that make up that
module. This section, which also contains background information to help you to set up
your contest later on, includes numerous images of a sample contest module to help you
visualize the design decisions that you will need to make when setting up your own
contest.

• The Administration and reporting section explains how to actually set up, review and
manage your contest.

◦ The Setting up your contest section outlines the steps that you will follow to set
up your own contest. This section explains how to use YouTube's contest
administration tool to define various settings and the schedule for your contest.
It also explains how to customize the visual elements of both your contest
module and a Gadget Ad for your contest.

◦ The Reviewing contest entries section explains how to review and either accept
or reject contest entries.

◦ The Reports section describes the statistics and reports available to contest
administrators.

• The Best practices for contests section summarizes ways that you can maximize the
impact of your contest. The guidelines provided in this section should be used in
conjunction with the best practices for brand channels outlined in the Creating and
Customizing a Brand Channel document.

• The media summary in Appendix A lists the graphics that you will need for your contest.
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Creating a YouTube contest

The following list summarizes the overall process that you will follow to set up your contest:

1. Sign up for a user account on http://www.youtube.com. The account's channel page will
be the brand channel page for your contest, and the YouTube username will appear in
your channel URL. The sign-up process is described in the Creating and Customizing
a Brand Channel document.

2. Provide the YouTube username from step 1 and a Gmail account name to your YouTube
media coordinator. The Gmail account will serve as the administrator account for your
contest, and the account name will not be displayed to YouTube users.

Two weeks prior to your contest launch, your media coordinator will upgrade your
channel to a brand channel with contest capabilities. Your media coordinator will then
send you the URL for the contest administration tool.

3. Create a Google Analytics account (http://analytics.google.com). (You can use the same
Gmail account that you used in step 2 to set up your Analytics account. In Google
Analytics, add contesttracking@gmail.com as an admin account for your Analytics ID.

4. Log in to the contest administration tool to enter general contest settings such as your
contest's terms and conditions and the Google Analytics ID that you created for your
contest. The Setting up your contest section explains how to use the contest
administration tool.

5. In the contest administration tool, define the phases of your contest. The Adding contest
phases section explains how to add a phase to your contest.

6. Customize the contest module for the first phase of your contest. At this time, also
customize the Gadget Ad for the first contest phase. Typically, a contest partner will
customize these modules for each subsequent contest phase two to three weeks before
that phase begins. However, once your account is created, you can set up contest
phases and customize the modules for those phases at any time.

The Customizing the contest module and Gadget Ad section of this document explains
how to customize the contest module and Gadget Ad.
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Contest phases

The following sections describe the phases of a typical YouTube contest, though you can
customize your contest to have a different number of phases. Each section shows a sample
image that demonstrates how the contest module might appear on the brand channel page. In
addition, each section describes the elements that contribute to successful execution of the
contest phase.

Phase I - Announcement and submission

Phase II - Viewing

Phase III - Voting

Phase IV - Results

Sample media execution

Phase I - Announcement and submission

During the first phase of a contest, a contest owner typically announces the rules, submission
dates, voting process and prizes for the contest. Generally, contest owners choose to also let
users submit video entries during this phase. (An alternate contest scheduling option is to
announce the contest in advance of its start date, thereby defining distinct time periods for the
announcement and submission.)

The following list identifies the key focus areas for this contest phase:

• Build awareness of your contest and brand.
• Clearly define all contest rules and regulations at the moment you announce your

contest.
• Use call-to-action videos to engage users and encourage them to participate in your

contest.

In this initial stage, contest owners display at least the Home and Submit tabs. Contest owners
also frequently display the View or Vote tab, enabling users to view or vote for approved contest
entries. Contest owners may also choose to display the Map tab or a Custom tab. Note that
contest owners who choose to define separate phases for announcement and submission would
not show the Submit, View or Map tabs in the first contest phase.
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The screenshot below shows a sample contests module for the first phase of a contest:

The following guidelines describe best practices for designing your contest module and running
your contest during this phase:

• Videos

◦ Create a featured video that provides a call to action encouraging users to
participate in the contest. The featured video might also include a sample
contest entry.

◦ Periodically update your call-to-action video to keep the content on your brand
channel page fresh and interesting to return users.

◦ If you plan to display the View or Vote tab during this phase, upload and
approve several sample contest entries to ensure that that tab always has
content to display.

• Contest information

◦ Include links to rules, external registration and information about your brand.
The contest rules should precisely describe the voting process for your contest.
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◦ Clearly identify the date and time when the submission period will end.

◦ Update the branding box, which is described in the Creating and
Customizing a Brand Channel document, to provide more information about
your contest directly on your brand channel page. The branding box could
include information that you would like to convey to users but that you may not
want to prominently highlight (or that may not fit) in the contest module's
content area.

• Visual elements

◦ Use vibrant, engaging graphics in the contest module's banner and content
area to announce your contest.

◦ Update your brand channel images – including the background graphic, the
channel page banner, the video page banner and so forth – to match the
background graphics that you select for your contest module.

◦ If you plan to embed your contest module on websites other than YouTube,
avoid selecting graphics that blend directly into your brand channel's
background image since these graphics may look strange when the contest
module appears on another website.

• Distribution

◦ Embed your contest module on third-party websites to raise awareness of your
contest and to drive traffic to your YouTube brand channel page.

◦ Distribute your Gadget Ad via the Google Content Network. Your Gadget Ad
can be displayed on any website that displays 300px by 250px Google Gadget
ads. It can also be distributed to websites that use DoubleClick's DART ad-
serving platform to display 300px by 250px ads.

• Community-building

◦ Create playlists that feature the top entrants for specific time periods. For
example, if your contest runs for eight weeks, you might create one playlist
each week to showcase the top submissions for that week. Use the Playlists
box on your brand channel page to feature this content.

◦ Use the Favorites Box on your brand channel page to highlight great user-
submitted videos. You could also mix in your own sample entries with top user
submissions.

◦ Encourage users to subscribe to your contest entries. Where does the
subscription link appear? Subscription is to all contest entries?

• Additional best practices

◦ Consider displaying a custom tab in the contest module to provide or link to
product logos, images and audio clips that you would want users to incorporate
into their contest entries.
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◦ If you have run the contest before, include footage from previous winners or
finalists. Entries from previous contests could also be featured in the Favorites
module or the Playlists module.

Phase II - Viewing

After the submission phase ends, a contest owner proceeds to identify the finalists and winners of
its contest. Although contest owners typically involve the YouTube user community in selecting
the contest winners, you can choose whether to allow user voting in selecting between several
different voting processes:

• The contest owner can select the finalists and then let the YouTube user community vote
to select the winner.

• The contest owner can let the YouTube user community vote to select the contest
winners from the entire pool of entries.

• The contest owner can define multiple rounds of voting. At the beginning of each round,
the owner can opt to reset vote counts.

• The contest owner can choose the contest winners without soliciting votes from the
YouTube user community.

This document describes the first voting process in the list above since that is the one that contest
owners most frequently choose. In that scenario, the contest owner defines a viewing period that
runs from the end of the submission phase until the announcement of finalists, which the contest
owner selects. After finalists are announced, the contest proceeds to its third phase, a voting
period when YouTube users vote to select the contest winners.

During the viewing period, contest owners usually display the Home tab and the View tab.
However, some contest owners still display the Vote tab (instead of the View tab) during this
period to encourage user interaction with their brands. If you do allow voting during this stage, you
can choose whether votes submitted for eventual finalists will count toward the final selection of
winners or whether vote counts will reset prior to the voting phase.

The following list identifies the key focus areas for this contest phase:

• Identify contest entries that embody your brand image while adhering to the rules of the
contest.

• Build enthusiasm for the voting round.
• Showcase contest entries that project your brand image in the playlists box and favorites

box on your brand channel page.
• Select contest finalists.

The following guidelines describe best practices for designing your contest module and running
your contest during this phase:

• Videos

◦ Create a call to action video encouraging users to view contest entries and
select their favorites in preparation for the voting round(s). In the video, remind
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users of the voting process. Many contest owners also choose to highlight key
statistics such as the total number of votes received and the entry pool size.

◦ Update your call-to-action video as the end of the voting phase nears. Use the
video to excite users about the pending announcement of the finalists and the
start of the voting phase.

• Contest Information

◦ Remind users of the process used to select finalists.

◦ Remind users of the date(s) when finalists will be announced and user voting
will begin.

• Distribution

◦ Update your Gadget Ad to reflect the change in your contest's status. Use the
Gadget Ad to drive traffic to your brand channel.

• Community-building

◦ Use the playlists box and favorite videos box to highlight contest entries that
project your brand image.

◦ Use the branding box to thank all of the people who entered your contest and to
encourage all users to prepare for the announcement of finalists.

Phase III - Voting

Generally, after the contest owner announces the finalists, the contest's voting phase begins. The
following list identifies the key focus areas for this contest phase:

• Encourage users to interact with your brand by voting for contest entries.
• Explain how user votes will impact your marketing strategy and/or the lives of potential

winners.
• Highlight contest entries that project your brand image on your brand channel page.
• Engage users with fresh content related to your brand and contest while rewarding brand

loyalists by publicizing their contest entries.
• Based on viewing statistics and votes, identify contest entries with messages that

resonate with brand enthusiasts.
• Select contest winners.

During the voting period, contest owners usually display the Home tab and the Vote tab. The
following guidelines describe best practices for designing your contest module and running your
contest during this phase:

• Videos

◦ Create a call to action video encouraging users to vote for contest entries. In
the video, remind users of the voting process. As in the voting period, you can
highlight key statistics such as the total number of votes received and the entry
pool size.
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◦ Update your call-to-action video as the end of the voting phase nears. Use the
video to highlight the impact their votes will have on the pending announcement
of the contest winners.

• Contest Information

◦ Remind users of the voting process used to select contest winners.

◦ Remind users of the date(s) when winners will be announced.

◦ If your contest has multiple rounds of voting, identify the dates when the current
voting round ends, the finalists for the next round are announced, and the next
voting phase begins.

• Distribution

◦ Update your Gadget Ad to reflect the change in your contest's status. Use the
Gadget Ad to drive traffic to your brand channel.

• Community-building

◦ Use the playlists box and favorite videos box to highlight contest entries that
project your brand image.

◦ Use the branding box to reinforce the importance of voting for contest entries.

Phase IV - Results

In the last contest phase, the contest owner announces the winners. The following list identifies
the key focus areas for this contest phase:

• Foster user retention by publicizing winning entries and encouraging visitors to your
brand channel to watch winning and other highly rated entries.

• Engage users with unique, user-submitted videos that project your brand image.

During this stage, contest owners that display the contest module typically show the Home tab
and the Results tab. Generally, owners make the Home tab the default view and show the
winning video as the call-to-action video.

The following guidelines describe best practices for designing your contest module and running
your contest during the results phase:

• Videos

◦ Use the winning video entry as the featured video on the Home tab of your
contest module.

◦ Select and rank other finalists to ensure that more than one video appears in
the scroller on the Results tab. Placing additional videos in the results tab
makes it easy for visitors to your brand channel page to locate and watch high-
quality content that projects your brand image.
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• Contest Information

◦ Review the contest dates and prizes.

◦ Provide a link to the official contest rules.

• Distribution

◦ Update your Gadget Ad to identify the contest winner and display the winning
video. Use the Gadget Ad to highlight the availability of other similar content on
your brand channel page.

• Community-building

◦ Use the contest module to identify and congratulate the winning entrant.

◦ Use the Branding Box to congratulate the contest winner and runner-ups. Also
use this area to thank users for their participation in the contest and to convey a
message about how their involvement in the contest affectds your brand.

◦ Use the Playlists Box and Favorite Videos box to highlight contest entries
that project your brand image.

Sample media execution

The table below describes a sample contest as it progresses through the four contest phases:

Phase I –
Announcement
and Submission

Phase II – Viewing/
Voting Phase III – Results

Focus Awareness and active
participation

Engagement Retention

Timing 4-8 weeks 2 weeks 2 weeks +

Media YouTube Display:
Upload path
Premium watch
Homepage roadblock
Google Network:
Search
Blogs/feeds
Targeted display
Contest gadget

YouTube Display:
Upload path
Categories/search
InVideo overlay
Homepage roadblock
Google Network:
Targeted display
Contest gadget

YouTube Display:
Promoted videos
Categories/search
InVideo overlay
Homepage roadblock
Google Network:
Targeted display
Click-to-play video

Creative Awareness: Contest launch,
prizes and teaser messaging;
user interaction: voting
launch, deadlines, call-to-
action and contest gadget
syndication

Call-to-action for voting, total
entry pool size, countdown
creative and contest gadget
syndication

See winning videos, click-to-
play formats

Tips for Success Exact submission deadlines,
terms and conditions, clearly
defined voting process,
confirmation email offers
additional marketing message
opportunity.

Highlight total votes received,
pool size, confirm method of
selecting finalists and/or
winners

Extend awareness for winning
videos via homepage and
network exposure
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Understanding the contest module and Gadget Ad

This section describes the graphic elements that you will use to showcase your contest on your
brand channel page and on third-party websites.

• The contest module, which is only available to contest owners, is a 560px by 465px
module that typically replaces the Featured Video module on a brand channel page.
You can also design your brand channel page so that a featured video appears below
the contest module.

The contest module can also be embedded on third-party websites.

• The YouTube Gadget Ad is a 300px by 250px module designed to advertise your
contest on third-party websites. The ad can be syndicated to websites that use
Doubleclick's DART ad-serving platform that displays 300px-by-250px ads. The ad can
also be shown on any Google Content Network site that displays 300px-by-250px
Google Gadget Ads.

The wireframe image below illustrates the layout of the contest module when the Home tab is
selected. The Gadget Ad is comprised of the same elements as the contest module, albeit at a
smaller scale. The Customizing the contest module and Gadget Ad section, which appears later in
this document, summarizes the specifications for all of the graphics that appear in these two
modules.
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The numbered elements in the sample display are explained in the following sections:

1. Contest module banner

2. Contest tabs

3. Splash graphic

4. Autoplay video box

5. Background graphic

1. Contest module banner

The contest module banner is a 560px by 140px image that appears at the top of the contest
module. You can provide an image map so that different areas of the banner will link to different
locations, including external websites. We recommend that you choose an image that is 20KB or
smaller for the contest module banner. The contest module banner displays regardless of which
tab is selected.

Specifications

• 560px by 140px image
• .jpg, .gif and .png formats allowed
• Recommended maximum size of 20kb
• Transparency allowed
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2. Contest tabs

The contest tabs that appear at the top of the module link to different phases of the contest. The
contest module displays additional tabs as your contest progresses through the various contest
phases. YouTube offers the following tabs:

• The Home tab is the default tab selected for your contest. This tab typically displays a
content area and call-to-action video as shown in the wireframe image above.
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• The Submit tab displays a multi-step form that lets the user upload a contest entry. The
images below illustrate the four steps in the contest entry process that take place within
the Submit tab interface:

Step 1: Step 2:

Step 3: Step 4:

The following steps describe the process by which a user submits a contest entry after
clicking on the Submit tab. The first four steps review the portion of the submit process
that takes place in the Submit tab interface.

1. The user clicks the Upload button to upload the contest entry to YouTube. After
uploading the video, or if the video has already been uploaded, the user clicks
the Continue button to proceed to the next step.

2. The user enters his or her YouTube username in the contest module and clicks
the Continue button to proceed to the next step. If the user is nominating
another person's video for the contest, then the user would enter the YouTube
username of that video's owner in this step. When the four steps in the Submit
tab have been completed, YouTube will send a confirmation email to the video
owner to ensure that the owner wants to enter the video in the contest.

3. The user selects the appropriate video to enter in the contest from all of his or
her uploaded videos. The user can preview any video by clicking the video
thumbnail image on the left side of the module. Before submitting the entry, the
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user must agree to the contest terms and conditions by checking the checkbox
below the video player.

4. The Submit tab displays a confirmation that the video was submitted to the
contest. This confirmation is the last content that appears in the Submit tab.

5. YouTube sends a confirmation email to the video owner's email address. The
images below display a sample confirmation email:

Inbox view:

Email content:

6. The user clicks the URL in the confirmation email and verifies that he or she
submitted the contest entry.

7. YouTube redirects the user to the Verification email redirect URL defined in
the YouTube contest administration tool.

Specifications

◦ The text font color is a global setting.
◦ Upload and Continue buttons cannot be customized.
◦ The contest owner can specify the maximum number of entries per user. The

default setting is one entry per user, and you can allow an unlimited number of
entries per user.

◦ The contest owner can provide a URL for a custom thank-you page, which will
be the target of the email confirmation link.
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• The Vote or View tab plays approved videos for the contest. When the user links to this
tab, an approved video will be randomly selected and played. At any time, the user can
choose to link to the next video, which will also be selected randomly.

◦ If you do let YouTube users give a thumbs-up or thumbs-down rating for
contest entries, then your contest module will display the Vote tab. The tab will
display "thumbs-up" and "thumbs-down" images so that the user can give a
positive or negative rating to the video. Users are allowed to submit one vote
per video per day.
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◦ If you do not allow users to give a thumbs-up or thumbs-down rating for video
entries, then your contest module will display a View tab.

Typically, contest owners choose to display a vote tab during all contest phases until the
winners are announced. We recommend that you structure your contest rules to clearly
define whether votes registered while you are still accepting contest submissions will
count toward the overall results. For example, if you plan to select a small number of
finalists before the voting stage, then votes registered before finalists are announced
may not count toward the overall total or may be weighted less heavily than votes
submitted after the voting stage officially begins.

In addition, contest owners who do not rely on user votes to select a winner might still
choose to display a Vote tab if the user votes will affect the selection of runners-up or
other prizes.
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• The Map tab displays a Google Local map that identifies the approximate location (city
and state) of 50 users who submitted approved video entries. The map displays a pin
graphic for each video. When a user clicks the pin graphic, a callout window expands to
play the video.

Users can use standard Google Maps controls to recenter the map and to zoom in or out
on the map.
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• The Results tab displays a scroller that shows the list of contest winners. The scroller
displays thumbnail images of the images above a video player. Users can click the
thumbnails to play each video and can scroll to see additional winners. The contest
owner can choose how many videos to feature in the results window, and YouTube does
not limit the number of selected videos.
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• A custom tab can display an image of your choosing. You can also provide an image
map to create links from the image to one or more external websites. Please note that
the custom tab can only contain a graphic and image map; it cannot contain forms or
other HTML content.

Specifications

◦ 560px by 300px image
◦ .jpg, .gif and .png formats allowed
◦ Recommended maximum size of 20kb
◦ Transparency not allowed
◦ Custom text label for tab. The maximum appropriate length for the tab label will

depend on the number of other tabs displayed in the module.

3. Splash graphic

The splash graphic and image map cover the 560px by 300px area beneath the tabs. Note that
the splash graphic only appears on the Home tab. On all other tabs except the custom tab, the
background graphic displays in this space.

The content area is the area of the splash graphic that is not allocated to the video player
module. As shown in the graphic below, the content area includes the large area on the left side
of the splash graphic as well as the area below the video player. (In the sample below, the splash
graphic uses the gold frame to outline the video player space.) You can also provide an image

Google proprietary and confidential. 21 of 36



map for the splash graphic so that the content area links to one or more different external
websites, pages on YouTube or other contest tabs.

Specifications

• 560px by 300px image
• .jpg, .gif and .png formats allowed
• Recommended maximum size of 30kb
• Transparency not allowed

4. Autoplay video box

The autoplay video box displays a 269px by 225px video player. (The video player controls
display in the bottom 25 pixels of that space, so that actual video area is 269px by 200px.)

Typically, contest owners run a call-to-action video in the autoplay box during the announcement
and submission phase of their contests. During the viewing and voting and results phases,
owners typically choose to show highly rated video entries or contest winners. Contest owners
can change the call-to-action video throughout the contest.

The call-to-action video plays automatically when your channel page loads. However, the video in
the Featured Video module also plays automatically when the brand channel page loads. For
that reason, contest owners typically choose to hide the Featured Video module if their contest
module displays a video. If your contest module does not display video, then you might choose to
display both modules.

To hide the Featured Video module, log in to your YouTube account and navigate to the Channel
Design page in the Edit Channel menu. Confirm that the checkbox for the Featured Video is
unchecked and update your channel settings.

Google proprietary and confidential. 22 of 36

http://youtube.com/my_profile_theme
http://youtube.com/my_profile_theme


Specifications

• 269px by 225px video player; video is 269px by 200px and video player controls are
269px by 25px

• Video player is offset 270 pixels from the left side of the splash page graphic and 5 pixels
from the top of that graphic.

• Any call-to-action video that you display must be uploaded to YouTube.

5. Background graphic

The background graphic and image map cover the 560px by 325px area beneath the contest
module banner. However, the background graphic functions differently on the Home tab and
custom tab than it does on the remaining tabs:

• On the Home tab and custom tab, the top 25 pixels of the background graphic appear in
the area to the right of the tabs, beneath the contest module banner and above the
content area and video player. The splash graphic, described below, functions as the
background for the remainder of the Home tab. Similarly, the image map for the
background graphic only operates in that 25-pixel high space.

• On all other tabs, the background graphic functions as the background image for the
entire area beneath the contest module banner. On these tabs, the image map is active
for the entire background image unless other content, layered above the background
image, supersedes links in the background image. For example, on the view page,
clicking on the video player will not trigger a link in the image map.

Specifications

• 560px by 325px image
• .jpg, .gif and .png formats allowed
• Recommended maximum size of 20kb
• Transparency not allowed
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Using image maps in the contest module

You can provide an image map for the contest module banner, splash graphic and custom tab
graphic, enabling these images to link to other contest module tabs or to external sites. The
following list explains how to define links in an image map. Note that the coordinates, as specified
in the <area> tags's coords attribute, will vary depending on the size of the image and the size of
the area within the image that you want to be an active link.

• The link target in the following example will open in a new window.

<area shape="rect" coords="0,75,300,150" href="http://www.google.com">

• The link target in this example will open in the area allocated to the contest module,
thereby replacing the contest module on the page. The rest of the page will not reload
when the user clicks the link. If the user clicks the link and then clicks the Back button in
the browser, the contest module will reappear in the contest module area. Note that in
the href parameter value, the text self: is prepended to the link target.

<area shape="rect" coords="0,150,300,225" href="self:http://www.google.com">

• The link target in the following example will be another tab in the contest module.

<area shape="rect" coords="0,225,300,300"
href="javascript:ytcp.contest.setSelectedTab(1);">

In the example above, the number 1, which is shown in bold text, identifies the tab to
which the link points. The number 0 identifies the first tab, 1 identifies the second tab and
so forth.

Please note that since the contest module displays different tabs during different contest
phases, the number associated with a particular tab may change when you transition
from one phase to the next. For example, while you are still accepting new contest
entries, the Home tab will be tab 0, the Submit tab will be tab 1, and the Vote tab will be
tab 2. However, since the Submit tab does not display during the Voting phase, during
that time, the Home tab will still be tab 0, but the Vote tab will be tab 1.

In the following sample image, the splash graphic, which occupies the lower 300 pixels of the
image, contains three areas that are linked using an image map.
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The numbers in the image correspond to the numbers in the following list:

1. The Submit a Video box that appears beneath the contest overview links to the Submit
tab in the contest module.

2. The See official Rules and FAQ text, which appears beneath the "Submit a Video" box,
links to a page on the contest owner's website. The link is configured so that the rules
page opens in a new browser window when the link is clicked.

3. The Watch Last Year's Winners text, which appears below the video player, links to a
YouTube video player featuring videos from a previous contest. The link is configured so
that when it is clicked, the video player will open in the contest module area.

The HTML code below shows the image map that links to these three areas.

<!-- This link opens in the same browser window. -->
<map name="youtube_contest_home_tab_Map">

<area shape="rect" alt="" coords="309,266,491,284"
href="self:http://example.youtube.com/acme_soda_last_year">

<!-- This link opens in a new browser window. -->
<area shape="rect" alt="" coords="38,275,177,285"

href="http://acmesoda.example.com/rules">
<!-- This link opens the Submit tab, which is the second tab. -->
<area shape="rect" alt="Submit a video" coords="18,216,227,266"

href="javascript:ytcp.contest.setSelectedTab(1);">
</map>
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Administration and Reporting

YouTube's contest administration tool enables you to enter and modify your contest settings, to
review contest entries, and to view and export contest statistics and submission data. The contest
administration tool is divided into three sections:

Setting up your contest

General contest settings

Adding contest phases

Customizing the contest module and Gadget Ad

Sample contest module and Gadget Ad

Reviewing contest entries

Viewing reports

Setting up your contest

The Contest schedule tab enables you to define the contest settings for different phases of your
contest. You have the option of deciding how many phases your contest will have. For example,
you could choose the finalists for your contest and then add another round of user voting. You
could also have finalists compete in head-to-head voting, where winners advance to subsequent
voting rounds.

Please note that any time you click the Publish Edits button, your changes will become publicly
visible. You can also click the Edit This Phase button to save changes for a contest phase
without publishing those changes. (Note that changes will only become publicly visible if the first
phase of your contest has started.) For example, if your contest has started and you change the
call-to-action video, your brand channel page will begin showing the newly selected video within
an hour.

General contest settings

• The Contest Ends field identifies the date at which the contest will no longer be visible
on YouTube. This field does not specify the date that the winners of your contest will be
announced. As of this date – that is, at 12:00:00 a.m. on this date – the contest will no
longer be listed on the Community tab of YouTube's website. In addition, after this date,
the contest module will return an error if it still displays on your brand channel. As such,
we recommend that you set this field to a date long after your contest ends – e.g. at least
eight to 12 months after the end of your contest. If you would like users to be able to see
the contest results for longer than that, the date can be set even further out.

• The Terms and Conditions URL field identifies the URL where your official contest
terms and conditions are located. Your terms and conditions can be hosted on your
servers or using a service like Google Pages (http://pages.google.com). A link to the
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terms will appear in the Submit tab and users must check a box indicating agreement to
those terms to submit contest entries.

• The Verification email redirect URL field specifies the URL to which users will be
directed after confirming submission of a contest entry.

• The Analytics Account field specifies the Google Analytics ID that you want to use to
track activity in the contest module and the YouTube Gadget Ad. To use this feature, you
must create an Analytics account at http://analytics.google.com and then copy your
Analytics ID – e.g. UA-#######-# – to this field.

• The Max submissions per user field identifies the maximum number of contest entries
that each YouTube user can submit. The default setting is one entry per user. You can
set the value to another number or leave the field blank to indicate that you do not limit
the number of entries per user.

• The Submission requires email confirmation lets you specify whether users will
receive an email asking them to confirm contest entries. We suggest that you always
leave this box checked.

After defining your general contest settings, click the Publish Edits button to save your changes.

Adding contest phases

To add a phase to your contest, click the Add a Phase button on the Contest schedule page.
Provide the following information for each contest phase:

• The Start Date and Start Time fields specify the date and time when a contest phase
begins. All times are for the Eastern time zone.

• The Home, Submit, Results and Custom Tab checkboxes let you specify which tabs
will appear in your contest module during a contest phase. For example, contest owners
typically would not display the Results tab until the last phase of a contest.

In addition, the View/Vote select menu lets you choose any of the following options for
that tab:

◦ No Vote Tab – The contest module will not display a View or Vote tab.
◦ View without voting – Users can view contest entries but cannot vote on those

entries.
◦ Up/Down – Users can give each video a positive, thumbs-up rating or a

negative, thumbs-down rating.
◦ Scaled – This option is currently not available.

• The Head to head checkbox is not currently in use.

• The New Round checkbox indicates whether vote counts should be reset when the
corresponding phase begins. Check the box to reset vote counts at the beginning of a
round. This option is only relevant for contests that have multiple phases of user voting.
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• The Default Tab select menu lets you choose the default active tab in your contest
module for a given contest phase. By default, the menu lets you choose either the Home
tab or the Submit tab.

To select another tab as the default tab, select all of the tabs that should appear for the
phase and then save the tab settings for that phase. After you save the tab settings, the
select menu will update to list all of the tabs that you have selected to display for the
phase. The view option in the menu identifies the View or Vote tab, and the winners
option in the menu identifies the Results tab.

After entering information for your contest phase, click the Edit This Phase button for the new
phase to save your settings.

Customizing the contest module and Gadget Ad

To customize the contest module or the YouTube Gadget Ad, click the Edit This Phase button
next to the phase that you want to edit. The following page lets you edit the graphics and color
settings for the contest module or the YouTube Gadget Ad.

Note: You can only save changes to one of the two modules at a time. To modify both modules,
make changes to the first module and then click the Save button for that module, which will
redirect you back to the Contest Schedule page. Then, click the Edit this Phase button for the
phase again and proceed to edit the second module and then save changes for that module.

The following lists explain the settings for each module:

• Large gadget (Contest Module) – This module is 560 pixels wide and 465 pixels high.
It can appear on your brand channel page and can also be embedded on third-party
websites.

◦ Media Summary:

▪ Banner graphic – 560px by 140px image in .jpg, .gif or .png format.
Maximum recommended size of 20kb.

▪ Splash graphic – 560px by 300px image in .jpg, .gif or .png format.
Maximum recommended size of 30kb.

▪ Custom tab graphic – 560px by 300px image in .jpg, .gif or .png
format. Maximum recommended size of 30kb.

▪ Background image – 560px by 325px image in .jpg, .gif or .png format.
Maximum recommended size of 30kb.

Note: These graphics are also described in the Understanding the contest
module and Gadget Ad section of this document.

◦ The banner graphic appears at the top of the contest module. You can specify
a URL to which the entire image should link or you can enter code for an image
map.
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◦ The tab color settings specify the hexadecimal color codes that you want to
use for the tabs in the module.

▪ The Main HEX fields specify the background color for active and
inactive tabs.

▪ The Border HEX fields specify the border color for active and inactive
tabs.

▪ The Font HEX fields specify the color of the tab names for active and
inactive tabs.

◦ The text color settings specify the hexadecimal color code that you want to
use for text in the module, including text in the Submit, View and Vote tabs.

◦ The splash graphic appears below the tabs if the Home tab is active. You can
specify a URL to which the entire image should link or you can enter code for
an image map.

◦ The custom tab graphic appears below the tabs if the custom tab is active.
You can specify a URL to which the entire image should link or you can enter
code for an image map. Note that the custom tab graphic fields

◦ The background image appears below the banner graphic on all tabs.
However, on the Home tab and custom tab, the background image only
displays in the 25-pixel-high tab area. That is, the image appears behind the
tabs and to the right of the tabs.

◦ The Call to Action video checkbox lets you indicate whether the contest
module will display a video. If you opt to show a video, enter the video ID for
that video in the Video ID field. The video ID is an 11-character string that
appears in the URL for the video:

http://www.youtube.com/watch?v=v5NYRGepdaQ

• Small gadget (YouTube Gadget Ad) – This module is 300 pixels wide and 250 pixels
high. It can be embedded on third-party websites and syndicated to Google's AdSense
for Content publisher network.
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◦ Media Summary:

▪ Banner graphic – 300px by 35px image in .jpg, .gif or .png format.
Maximum recommended size of 20kb.

▪ Splash graphic – 300px by 190px image in .jpg, .gif or .png format.
Maximum recommended size of 30kb.

▪ Custom tab graphic – 300px by 190px image in .jpg, .gif or .png
format. Maximum recommended size of 30kb.

▪ Background image – 300px by 215px image in .jpg, .gif or .png format.
Maximum recommended size of 30kb.

Sample contest module and Gadget Ad

The image below shows a sample large gadget in which the Home tab is active. The three
graphic elements – banner graphic, splash graphic and background image – are all solid color
images with labels identifying the image size. Note that the splash graphic covers the bottom 300
pixels of the background image. In addition, the module has the following tab color settings:

• Main HEX (Active): #FFFFFF (white) - Color for active tab (Home).
• Main HEX (Inactive): #FF00FF (fuchsia) - Color for inactive tabs. Inactive tabs are not

shown in the small gadget image to ensure that the background image is clearly labeled.
However, in practice, the small gadget displays the same tabs as the large gadget.

• Border HEX (Active): #00FF00 (lime) - Outline active tab.
• Border HEX (Inactive): #0000FF (blue) - Outline inactive tabs.
• Font HEX (Active): #000000 (black) - Font color for active tab.
• Font HEX (Inactive): #FF00FF (white) - Font color for inactive tab.
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The image below shows a sample small gadget with the same color settings as the large gadget
shown above. In this module, the only tab shown is the Home tab. The other tabs are not
displayed to ensure that the label on the background image is visible. In actuality, during any
contest phase, the large and small gadgets will show the same tabs.
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Reviewing contest entries

Contests owners have complete control over the videos that are actually approved as legitimate
contest entries. When a user submits a video to your contest and confirms the entry, the video will
appear in the list of pending videos on the contest administration tool's Contest Management
page. You can watch each video and then approve or reject it as a contest entry. Only approved
videos will appear in the View or Vote tab of your contest module or Gadget Ad.

The Contest Management tab offers the following views of contest entries:

• Pending entries are videos that have been submitted to your contest but have not yet
been approved or rejected. The tab displays a list of videos waiting to be reviewed.

The following list describes the numbered elements in the image:

1. The tabs at the top of the page let you switch to view lists of approved videos,
rejected videos or winners.

2. The video player lets you watch any pending video in the list. Click on the
thumbnail image of a pending entry to change the video displayed in this area.

3. The video details display the title, description, owner, location and submission
time for the entry. You can also use the field provided to enter a caption for the
video. Captions will display on the View and Results tabs.

4. The Approve and Reject buttons allow you to moderate each video. Clicking
one of these buttons will move the corresponding entry from the Pending tab to
the Approved or Rejected tab as appropriate.

5. This area shows a thumbnail image and video details for a pending entry. Click
on any thumbnail image to view the entry in the video player.

6. The search box and pagination links help you to locate more pending entries.
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• Approved entries are videos that you have reviewed and accepted as valid contest
entries. Like the view of pending entries, the view of approved entries shows a list of
entries accompanied by a video player.

The following list summarizes the ways that the information and options available in this
view differ from the information and options in the pending view.

◦ The details for each video display the number of views for each video, the
number of votes for each video and a score based on the viewing and voting
statistics.

◦ Instead of a button to approve each video, this view displays buttons to help
you select the contest winners. The Winners tab lets you rank winning entries
for the Results tab.

Note: You can change the status of a video from approved to rejected.

• Rejected entries are videos that you have reviewed and declined to accept as valid
contest entries. Like the other views, the view of rejected entries shows a list of entries
accompanied by a video player.

The functionality for rejected videos is virtually identical to that for approved videos
except that you cannot mark a rejected video as a winner. You can change the status of
a video from rejected to approved.

Note: To select finalists for a contest, you need to reject all non-finalist entries.

• Winners are entries you have reviewed, approved and subsequently designated as
winners in the view of approved entries. The list of winners will appear in the Results tab
of your contest module. The view of winning entries lets you rank the winners as they
should appear in your contest module. You can also remove an entry from the list of
winners or even reject it from this tab.

Viewing reports

The Contest Report tab in the contest administration tool lets you access statistics, daily reports,
and detailed entry submission data. The reporting interface provides the following information:

• Contest statistics

◦ Total number of users who have viewed videos submitted to your contest.
◦ Total number of votes cast for videos in your contest.
◦ Total number of videos submitted in your contest.
◦ Total number of submitted videos that you approved.

• Export submission data

◦ Reports are available in XML or CSV format.

◦ Reports can be downloaded for all contest entries, all pending entries, all
approved entries or all rejected entries.
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◦ Reports include the following fields:

▪ video_id - A unique ID that YouTube uses to identify a video.
▪ title - The title of the video.
▪ url - The URL for the video on YouTube.
▪ user_name - The YouTube user who submitted the video.
▪ views - The number of times the video has been viewed on YouTube.
▪ votes - The number of votes that the video received.
▪ scores - A weighted score that accounts for viewing and voting

statistics.
▪ submit_time - The date and time when the video was submitted.
▪ last_moderation_time - The date and time when you last modified the

video's status.
▪ status - The video's status in your contest. Possible values are

pending, approved and rejected.
▪ geo_location - The location of the user who submitted the video.
▪ category - The YouTube category used to classify the video.

• Per-day reports include the following information for each day during the submission
and viewing/voting phases of your contest:

◦ Total number of times videos in your contest were viewed.
◦ Total number of votes cast for videos in your contest.
◦ Total number of votes that users attempted to submit for videos in your contest.
◦ Total number of videos submitted in your contest.

Best practices for contests

This section summarizes best practices that can maximize the impact of your brand channel:

Administration

• Create compelling call-to-action videos for each contest phase.

• Assign resources to manage your contest and respond to customer inquiries. By clearly
defining the contest rules, prizes, deadlines and entry requirements, you will be able to
reduce the need for resources.

• Review all contest entries to manage brand acceptability.

Selecting prizes

Frequently, publicity and recognition can be as valuable or more valuable than financial prizes.
The following list identifies several different types of prizes that have been awarded to previous
YouTube contest winners.

• Winning videos have been broadcast on network television as ads for the brand running
the contest.

• Contest winners receive experiences, such as the opportunity to meet or perform with a
celebrity or band.

• Winners receive a prize package featuring the sponsor's products, such as a vacation
package, musical equipment or an automobile.

Google proprietary and confidential. 34 of 36



Frequently, contest sponsors will combine a financial prize with another prize that provides some
type of public recognition for the winners or winning videos.

Scheduling

The following list identifies additional best practices associated with particular contest phases:

• Phase I: Announcement and Submission

◦ Define clear and finite rules to inform users about your contest and aid in the
vetting of user submissions.

▪ Announce submission deadlines.
▪ Announce prizes.
▪ Publish terms and conditions of contest.
▪ Explain voting method.

◦ Provide users with sufficient time to prepare their contest entries before the
submission phase begins. We recommend that you announce your contest
three to five weeks before you will begin accepting submissions. Shorter time
horizons may not provide sufficient time to build awareness about your contest,
while longer time horizons may cause users to lose interest in the contest
before it actually begins.

◦ Encourage contest participation by highlighting recent submissions in the
Videos box on your brand channel page.

◦ Create playlists that feature the top entrants for specific time periods. For
example, if your submission period is four weeks long, you might create one
playlist each week to showcase the top submissions for that week. Use the
Playlists box on your brand channel to feature this content.

• Phase II: Voting

◦ Restate the process for selecting the contest winner(s). Confirm important
dates during the process, such as the time when finalists and/or winners will be
announced.

◦ Use call-to-action videos to encourage user interaction with your brand during
the voting period.

▪ Let users vote to select the eventual contest winners. Users can vote
on the entire set of entries or you can choose a set of finalists and let
users vote on those.

▪ Even if user votes do not influence results, you can still encourage
users to watch and submit comments about the contest entries.
Comments and viewing statistics may help you to identify the contest
entries that best resonate with your audience.
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• Phase III: Results

◦ Extend awareness for winning videos through your brand channel page,
website and other media outlets.

◦ Feature additional content related to contest winners, such as behind-the-
scenes interviews, footage of the winners learning the contest results, or other
videos about your brand that the winners may have made.

Appendixes

Appendix A - Media Summary

The following list provides a media summary for the contest module (large gadget) and the
Gadget Ad (small gadget):

• Contest module

◦ Banner graphic - 560px by 140px image in .jpg, .gif or .png format. Maximum
recommended size of 20kb.

◦ Splash graphic - 560px by 300px image in .jpg, .gif or .png format. Maximum
recommended size of 30kb.

◦ Custom tab graphic - 560px by 300px image in .jpg, .gif or .png format.
Maximum recommended size of 30kb.

◦ Background image - 560px by 325px image in .jpg, .gif or .png format.
Maximum recommended size of 30kb.

• Gadget Ad

◦ Banner graphic - 300px by 35px image in .jpg, .gif or .png format. Maximum
recommended size of 20kb.

◦ Splash graphic - 300px by 190px image in .jpg, .gif or .png format. Maximum
recommended size of 30kb.

◦ Custom tab graphic - 300px by 190px image in .jpg, .gif or .png format.
Maximum recommended size of 30kb.

◦ Background image - 300px by 215px image in .jpg, .gif or .png format.
Maximum recommended size of 30kb.
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